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The AutoCAD® Tool Belt

Michael Beall - AutoCAD Trainer Guy, LLC

GD13-2 The session is designed to improve the productivity of the daily AutoCAD user. You will learn how to
apply some less-than-intuitive features of AutoCAD related to editing, blocks, palettes, and the user
interface that directly impact the speed of project completion. Fresh ideas will also be suggested on
what to do when you receive drawings from elsewhere. Presented from a "what-do-l-use to ..."
perspective, practical applications are shown that can be used the moment you return to the office.

This session loads up your AutoCAD tool belt so you won't have to stop and read all the directions to
get the job done.

About the Speaker:

Michael is the owner of AutoCAD Trainer Guy, LLC, and has been presenting on-site CAD training
seminars domestically and internationally to the A&D community since 1982. He has presented
AutoCAD productivity sessions at NeoCon since 2003 and was keynote speaker at the 2005 NCC
Conference. Michael is the publisher of The AutoCAD Toolbelt newsletter and recently authored
AutoCAD 2006: Transitioning from AutoCAD 2002 to AutoCAD 2006 [AOTC]. He is an ACI at the
University of Louisville and received Autodesk's Instructional Quality Award in both 1997 and 2000.
Michael received his Bachelor of Architecture degree from University of Cincinnati.

michael.beall@autocadtrainerguy.com
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AutoCAD Popcorn: Tools Too Cool to Wait

Mask the Dimension Text from the Text tab!

Choose a Color or use 'Background'.

If needed, use Tools > Draw Order >Text and Dimension Objects [TEXTTOFRONT]

Edit Text W 17\
]
DTEXTED <1> ...0r <0> Re’ialm 5
Text: IRetaining v,f"-——__,__/-”"
—

Realtime text is fine, but sometimes you just want it the way it used to be.

MTJIGSTRING = o e o
gy ‘ | Hu| i |
"abc" is boring. Put up to 10 alphanumeric
characters for the sample text of the Mtext @
command. (KrispyKreme has 11)

Put a Qleader Block on a Palette set to Explode J

JNSTALL 24" CONCRETE
PAVYERS PER SPFEL.

Then click the
Arrowhead grip and B O S TEXT
use the Copy
option.

QL+TEXT:
Quick Leader; Exploded

GOLD STAR Tip - Qleader settingsareretained in a template.



The AutoCAD® Toolbelt

| TOOL NO. 1: Rotate to Parallel. Rotate any object to be parallel [ oo
] :

to another object.
Since ¢ A2000

Instructions to Rotate to Parallel with Reference [Skewed to Skewed].

1. On the Status bar, right-click Osnap and click Settings.
2.. Turn on Endpoint, Parallel, and Object Snap On, then click OK.
3. Launch the Rotate command, select the objects to rotate, and
specify a Basepoint, (shown in the figure with a red dot). .
4., At the prompt for a rotation angle or Reference, enter R. HH‘““\\H\
5.. Pick two points (Ex: the red diamond and blue dot) that BRhi

graphically specify the reference angle.
6.. Now position your cursor over a vector to acquire its angle for the parallel snap.

%
7.. Move your cursor back to a position parallel to the acquired angle.
8.. When you see the tooltip, click to complete the parallel rotation.

| TOOL NO. 2: Master Drawing Information in 5 Seconds. Not your drawing?
mam| Grab your favorite settings to make it your own ... in 5 seconds or less!

FACT #1: AutoCAD drawings contain several tables of information, or "named objects", including
Blocks, Dim Styles, Layers, Layouts, Linetypes, and Text Styles, per the DesignCenter nodes.

Tool Palette Macro to Insert a Master Drawing (substitute your Master drawing "name as necessary):
ACAC-INSERT;"*ATG MASTER";0,0:1;;

When you click this macro on the palette, it will...

... Issue the command line version of the INSERT command.
... Insert + Explode the drawing “ATG Master” (that's the function of the *).
... Place the drawing at 0,0.
... Setthe scaleto 1.
. Issue an <Enter> for the default rotation of 0.

Material acquisition (1x): Master drawing creation — 30 min. from scratch
Macro creation on a blank button — 1 minute
Implementation: 2 seconds
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GOLD STAR Tip - When creating your favorite Styles (Dims, Text and Tables), don't edit
'Standard’, create unique style names.

The importance of using a Script to establish your settings.

FACT #2: There are 400+ variables in AutoCAD 2006 (69 of which are DIM vars).

FACT #3: Some variables are drawing-specific (i.e., MIRRTEXT, BLIPMODE) and some are set in the
registry (i.e., GRIPCOLOR, ATTDIA).

Instructions to Create a Script File of Variables.

; read-only - VSMIN (-12918.8 -775
There are a number of ways of ‘capturing’ your variables, but here’s || 1ea4-9ny = WoREJCR )

one | learned years ago from Hugh Bathurst. ; read-only - _PKSER 400-57166125
; read-only - _SERVER 1

read-only - _VERNUM Z.54.10

1. At the command line, enter VARS2SCR. If this does not (setvar "ACADLSPASDOC" 1)
result in a dialog box to save your script, enter (load e
"acadinfo") first. e

2.. Navigate to the desired folder, then save the .SCR file. This Setvar APBOX? 0)

file can be run as-is.
Tool Palette Macro to Run the Script (substitute the name of your script as necessary):

NCMCSCRIPT;ATG.SCR

Material acquisition (1x): Running the VARS2SCR routine - 2 seconds
Macro creation on a blank button — 1 minute
Implementation: 2 seconds

Macro Alternative.

If you don T have the time to create a blank button, you can always drag and
drop the Master drawing and the Master script file from Windows Explorer
into the current drawing.

GOLD STAR Tip - If you drag and drop a drawing onto the Command line, AutoCAD
opensthedrawing. If you drag and drop a drawing intothedrawing area, AutoCAD
insertsthedrawing as a block.
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| TOOL NO. 3: workspaces. Putting Humpty Dumpty back on the wall after your
=8| Toolbars, Palettes and Properties have fallen all over the place.

As the CUI dialog box says, Workspaces save the visibility and position of ...
Toolbars, Menus, and Dockable Windows. (Including the Scroll bars! )

Instructions to Create a Workspace from the Toolbar.

Similar in procedure to creating a Profile, the quickest way to make a s -~ ~
Workspace is to set up your work environment, then Save As. ( )
1. Position your toolbars and palettes (including DesignCenter and ~ -

. : ~
Properties) as desired. _——

2.. From the Workspaces toolbar, open the dropdown list and click Save Current As. Enter a
name for the Workspace.

To set a default Workspace (My Workspace):

1. On the Workspaces toolbar, click Workspace Settings to open the dialog box.

2.. In the My Workspace = dropdown list at the top, select a default workspace.

To Make Changes to a Workspace:

Dilemma: How to update a Workspace with changes since there s no place where it says, "Already
exists, do you want to replace?"

First.. Open the Workspace Settings dialog box. (~ Do not save changes o workspace

Next.. Under When Switching Workspaces, click Automatically Save O Ao e TR
Workspace Changes, then click OK.

Then.. With your default Workspace current, make the desired changes to the arrangements of the
workspace elements.

Now.. Testthe arrangement by selecting a different workspace (such as AutoCAD Default), then
click My Workspace (which returns to your default).

When Switching Workspaces

Finally.. If that works, go back to the Workspace Settings dialog box and return the setting to Do Not
Save Changes To Workspace. Click OK.

Unigue Workspace Features in the CUI:

Toolbars can be arranged better
within the drawing environment, but

s N Menus are better addressed in the
\ ) CUL. In the Customization pane (top
~ A left), click the workspace name to be

edited.

Under Workspace Contents, expand the Menu node.
Drag a menu to a new position as desired.
Right-click a menu to open the shortcut menu if you want to delete it.

oo w>»

When you want to ADD content, click the Customize Workspace button.
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[Al| TOOL NO. 4: Fields. Automating the collection of resident data.
]

Since ¢ A2005

Wouldn't it be cool to have the area

. L Field x|
of a closed polyline update when the |=
polyline changed? Associate a field — i Learn about Fields
to an object, then update the field Field category: Object type: 7 - preWem: "ﬁ
when the object changes. In the Ja | |[polyiine | 2565064 S -,"T-
following example | traced the Field names: Property: ‘ :
perimeter of a room with a polyline Hypernndkaase -] =
K Cl
on a separate layer. LatSavedsy ol
Login Elevation _I
NamedObject Global width Enainaarinn
. . . Layer Precision:
Instructions to Assign a Field to a PageSetupName Length Current precision ~|
Polyline and Update the Value. Taperthe L
1. After creating a closed polyline, launch the Field
command (Insert >Field).
2.. In the Field Names list, select Object, then click the
Select Object button and select the closed polyline.
3. The Field dialog box will re-open with properties related |
to the selected object with the Area property at the top. 254.90 SQ. FT.
4. Select a Format and a Precision from the respective lists, ‘
then click OK.
5.. The Mtext indicating the area of the selected polyline is
attached to the cursor. Change the Height as needed.
6.. Specify a location for the field.
7. Launch the Stretch command and change the shape of

the polyline. In this exercise, | increased the size of the
mechanical chase in the upper left corner of the room. |

8.. To update the field, regenerate the drawing. \

NOTE: The variable Fieldeval specifies when a field is to be
updated. (See Express >Tools >System Variable Editor) The
default value of 31 specifies that a field is to be updated when
its associated information is modified.

And for those of you doing civil engineering ... or creating golf courses in your spare time ... assigning
a field to an object is a great way to keep track of the square footage of the area of a closed spline
during the design phase of your project!

To give credit where due, | found that field trick on Shaan Hurley’s
website, http://autodesk.blogs.com/between_the lines. His site has
lots of links and AutoCAD tips and he’s very diligent about updating
his site several times per week.

67295 2@, FT.
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m’ TOOL NO. 5: Reassign Keys and Key Combinations. F1 is a perfectly useful
o

function key ... make it functionally Helpful.
+ A2006

Instructions to Customize a Key Combination. -

1. Open the CUI dialog box. In the Customizations pane, expand
the Keyboard Shortcuts node. [ %= 80|

2.. In the Command List pane, click New to create Commandx. | Bceneral . I
Under Properties, enter a name for this procedure you will be ription BCOUNT
assigning to a key combination; BCOUNT in this example. D o o - I
Notice there is no field for a KEY assignment at this point! = ==

Sidebar: The Bcount command is part of the Express Tools and counts the quantities of all the blocks
in the drawing if you press <Enter> at the prompt.

4. Under Command List, drag BCOUNT up into the Ul list and release it next to
Shortcut Keys to add BCOUNT to that listing. Under Properties you will now
see there is a line for a KEY assignment!

5 Under Properties, edit the Macro edit box to read: *C*"CBCOUNT;; TEXTSCR

- —

E|JJ Keyboard Shortcuts
¢ E-iaf Shortcut Keys 4
i i Distance

: \ ;u.;.l;..la

6.. Click in the Key(s) edit box, then click the ellipsis to open the Shortcut Key
dialog box. ,
L . . € LU | Commands
7. Click in the Press New Shortcut Key box, then press Ctrl+B. Click Assign to
assign that key combination, then click OK to close the dialog box. (s
' Baseline
B General
MName BCOUNT Dol s ha
e ommnplioen — o - - - -1
I B Macro . .
Macro ~c~cBCOUNT:TEXTSCR || NOTE: If Caps Lock is on when you specify the key
l|2 Access combination, a +SHIFT will be added, i.e., CTRL+ SHIFT+ B.
Key(s) CTRL+B |

Instructions to Assign the 'Distance’ Command to F1.

1..  Open the CUI dialog box. In the Customizations pane, expand | [Eihac
the Keyboard Shortcuts node.
. . . . Type: Iﬂu:-:el-':ratu:-r Keys LI
2.. Under Command List, drag Distance up into the Ul list and :
release it next to Shortcut Keys to add it to the listing. Name [ Keys |
3. Under Shortcuts next to the Distance command, click in the j‘giTS“a' 'B_f'SiC--- A#TT_FH
Keys column to display an edit box, then press F1 and press " HC?JNT— —ETELL:BN
<Enter>. = 4| — Distance |
. [\in o — = ‘~ -
4.. Click the Name header to sort the "~ DesignCentsr CT’&—RL+2\ =
column. ( +/ Distance F1
Exily, _CTH#[{
A Hyneding CTRI K

NOTE: If the recently added command does not initially appear under Shortcuts, you may have to OK
out of the CUI, then re-open it.
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AL TOOL NO. 6: Importing Toolbars. How to
mo

Transfer your A2005 (and earlier) Toolbars.

Quick review of making a custom toolbar in A2005, then we look

at how to transfer it into A2006 using the CUI.
o A2006
A. Default Location of A2005 Menus...

C.\Docunents and Setti ngs\Your_ Nane_Here\ Application Data\ Aut odesk\ Aut oCAD
2005\ R16. 1\ enu\ Support

...or check with your IT professional.

Bl custom.mnc | Names of the files created when you created a toolbar in the Custom menu

&l custom.mnr | group. Be sure to close AutoCAD after creating the custom menu. When you re-

&l custom.mns [ open AutoCAD, the MNC file will be created. Do NOT rename them; bad
career move.

Instructions to Transfer a Custom Menu from A2005 to A2006.

L. Open the CUI, then click the - —
Transfer tab. e — E—rJ
2.. Under Customizations In New CUI [ — 18 Workspaces ,
File, click Open Customization = S L Open customization file
File, then navigate to the A2005 —=
.\Support folder (in Montana). 1 *-=; e
3. Change the Files Of Type to Menu Files, then double- click E-ER AU_DD
Custom.MNS E|““ A2005 Custom Toaolbar
. . = +r Revcloud
4. Expand the Toolbars node to see the imported custom toolbar(s). g::* 30 Orbit
5.. Now drag your custom toolbar and release it on the Toolbars node ----- ¥r Lengthen
under Customizations in Main CUI to add it to the list. % LayerWalk
6.. Click OK to apply the changes and close the CUI. . ¢ What's Here?
If your A2005 custom toolbar contained tools
from Express or User Defined tools, you may
not see the icons on the buttons. For
Express tools, find the tool in the CUI.
Adding Icons to the A2006 Toolbar.
1. In the CUI, under Customizations in — e mmm
Main CUI, click on the imported [ 1
toolbar that has no icon association. I |
2.. Under Button Image, click Edit, then — s a—————
click Open and navigate to the folder where you saved the _ _ e
custom BMP images for your custom A2005 toolbar. = Images
Smallimage RCDA7513.bmp
If you did not give them specific names, under Properties you will see Lareimage RCDATA 16 BLANK

the name associated with that button.
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3. Select the BMP, then click Open. In the Button Editor, click Save, |sSsaiiss

then click Close. " Large :I
4., Under Button Image, scroll to the bottom of the icons and click on C Small / -~

the selected BMP. You will see it under Command List, (@ Both

associated with your command. L{
5.. Click OK to close the CUI ... then be sure to turn on your 30 Oror

imported toolbar! v A2005 Custom Toolbar

AU_05

Intermission ... & more AutoCAD Popcorn

T I T
Poor Man’s Document Manager: HYPERLINK! & Hyperink
Automatically open any file or Windows application. -~
1. Insert >Hyperlink [Ctrl+K]
. . . ir Info_HMI Site
2.. Paste a URL or click File to browse for a file. | cTRL + cick to follow nk
3.. Change the Text To Display to something less cryptic. H ﬂ:ﬂ B ‘.r—m \l\
—r___________-
GOLD STAR Tip - Includea |
Hyperlink layer in your I_ —_— — e e = 4
template.
Consider making shapes that represent
hyperlink targets: Word, Excel, 3rd party
application, PowerPoint, Image file, etc.

Poor Man’s Property Manager - Layer & Other Object Properties for Palette Stuff!

h In the Tool Properties dialog box for palette items, you can specify object

Color B syLayer properties to 'steer’ where the tool functions reside.

Layer Mot . . . . .

Linetype B:L::er Named objects that will automatically be added to the drawing if they are
Linetype scale 24.0000 not there:

TG 7 use current A. The Layer and Color

Lineweight ByLayer

Text style Notes B. The Text Style with all of the associated elements

Dimension style ATG default

C. A Dimension Style with all the associated variables

Faster Distances with Lengthen!

% SUECT

When querying distances of as-built drawings, Lengthen is faster than all others.
Sel ect an object or [DEltal/Percent/ Total/DYnamic]:
Current length: 1'-11 11/16" 2~ Trim

Sel ect an object or [DEltal/Percent/ Total/DYnamic]:
Current length: 8 -3 1/8", included angle: 9.47

~# Lengthen
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., o o o o o . o o o

o o] o]

A3 A3 A3 A3 A3 A3 A3 A3 A3 A3 A3 A3 A3

Finally, an Editable Scale List!

Add &m, Move &m, ... or Delete &m!

AL
[

TOOL NO. 7: Palette Power. Making a Blank Button in AutoCAD 2006.

The CUI and palettes are covered extensively at AU, but | just wanted to give you a quick look at how
to get a blank Command button onto a palette. Copy it all you want after that. It's like having a duplex
receptacle in your barn; you can do so much more when you have it.

What We Know About the A2006 Interface Features:

A. You can't drag anything out of the CUI. 7, AUStf E
2 <

B. The CUI doesn't display palette information. E .k S — ;
C. The Customize dialog box in A2006 is for palette operations only. i =
D If the Customize dialog box is open, you can drag stuff between toolbars '

& palettes...

... Ergo/Therefore/So...
E. You can drag a blank button from a toolbar onto a palette!
e it e e

Instructions to Add a Blank Button to a Toolbar [A2006]. || [ General |
1..  Open the CUI. Under Command List, click New to create a new gz;"jimim BlankBution ., I

Commandx in the list. et
2.. Under Properties, enter a name (like BlankButton), then press <Enter>.
3. Drag BlankButton out of the Command List area and release it on an R ;\Nﬂcﬁc s

.. . . “L" ichael's Stu

existing toolbar or one you have created. This copies the button to the ; TR RodT g,

toolbar. Y =-22AU0S « N 1
4.. Click OK to apply the additional button to the toolbar. Close the CUI. \EE g‘fgﬁfumgn -

(The Bmiley face "is no longer; now it5 a mystery cloud. Fine, whatever.) [m-a0 K=o smmsHE uts

T ouco Bhibdon

5.. Open the Tool Palette, then right click on the title bar and click “ :

Customize to open the (now palette-specific) Customize dialog box.
6.. Drag the BlankButton tool from the toolbar onto the palette. Done!

Cool Things to Add to a BlankButton [A2005 & A2006]...

~CMCOSMODE;8193 - A macro to set the OSNAP to Endpoint and Parallel
ACNCUCS;OB;\PLAN:;; - A macro to set the UCS to the selected line.

ACACLAYOUT;T;"Drive:/Path/Filename.dwt" - Select a Layout in the dialog box.
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/L |
[

Less than intuitive but worth the effort, dynamic blocks are amazing. Here
are the steps to set up a left-hand door to go from 24" to 48" in 6"
increments, flip it, and make it align to an object.

General Information:

TOOL NO. 8: Dynamic Block Fundamentals. Steps to
Create a Dynamic Block with Stretch and Scale Parameters.

A. You should have a block to start with.

B. Parameters ('What' to modify) come before Actions (‘(How’ to modify it).

C. The Block Editor is your friend; you're still in AutoCAD. Don't panic.

D. The Properties palette is critical to the customization of the parameters and actions.

E. More than one Action can be assigned to a single Parameter.

Instructions to Add a Numeric Incremental Scale to a Door Block. %Scm

1. Double-click your door block to open the Edit Block Definition dialog box,
then click OK.

2.. On the Block Authoring Palette, on the Parameters tab, click Linear Distarcs
Parameter.

3. Use Endpoint snap and click the lower left corner of the door, then the end of the door arc to
specify the Linear parameter endpoints. Place the label below the door. (The yellow exclamation
point means no Action has been assigned to that parameter.)

4. On the Actions tab, click Scale Action, then click the blue parameter arrowhead at the end of the
arc.

5.. When prompted to specify the selection set for the action, click the arc, then press Enter.
Position the action icon off to the side. (The yellow exclamation point is cleared.)

6.. To specify the direction of the door scaling, click the Distance label,
then open Properties. m

7. Under Misc, change the Number of Grips to 1. LEiLTE Increment

8.. Under Value Set, change the Dist Type to Increment, then make the DfSt m_cr_ement 6, -

. . . . . Dist minimum | 2'-0
changes shown in the figure. After closing Properties, you will have Dist man n
one blue Distance parameter and 5 incremental marks between 24" and 1S maximim
48".
9.. Close the Block Editor and Save changes. ﬂ Frn]
Distance

Instructions to Add a Stretch Action to the Door Block.

1.

Double-click the dynamic door block and open the Block Editor. On the Actions tab, click Stretch
Action.

When prompted to Select Parameter, click on the right side of the Distance label so the second
point of the Distance parameter is taken as the default parameter point to associate with the
action.



7..

Press Enter to accept the default value of <Second>, then specify
the two corners of the stretch crossing window around the top of
the door as shown.

When prompted to specify the objects to stretch, select the
geometry of the door only (be sure to not include the arc), then
position the action icon over on the side.

Click the Stretch action icon, then open the Properties palette.

On the Properties palette, under Overrides, set the Angle Offset
to 90.

Close the Block Editor, save changes, then test your door block.

Instructions to Add the Alignment Parameter.

1.

Double-click the dynamic door block and open the Block Editor.
On the Parameters tab, click Alignment Parameter.

For the base point of alignment, specify the insertion point of the
door block at the hinge.

Specify the second point of the alignment at the end of the arc
for the door swing.

Close the Block Editor, save changes, then test your door block!

GOLD STAR Tip - Turn on Dynamic Input to seethe size
when dynamically changing the door.
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Distance

Distance

Thank you for including my session in your AU 2005 experience. Please feel free to contact me at anytime.

My email michael.beall@autocadtrainerguy.com
My website www.autocadtrainerqguy.com

Michael's Corner www.cadtutor.net/michael/index.html
Corner Archives www.cadtutor.net/michael/archive.html

Ask me for a $100 discount coupon
for my onsite, customized AutoCAD productivity training.

Left Field

Horses can only breathe through their nose ... and can't burp.

The root-like, glassy tubes that lightning sometimes makes when it hits dry sand are called
"fulgurites", informally called solidified or petrified lightning bolts.

The longest on record is 17'.







